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• Lightning Network: Short introduction 

•Preliminaries: Some necessities for further understanding

•Data set

•Node Classification: Labeling nodes in the data set 

•Geographical Analysis: Client distribution and node connections

• Summary
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Today’s talk 



•Off-chain network 

•Created to counteract the scalability problem in blockchain systems i.e. Bitcoin

◦Due to
 Consensus protocol

 Missing trusted third party authority

•Allows making direct payments between users without involving the blockchain
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Lightning Network Overview

Alice Bob



•Currently three main clients available

◦ LND (Go)

◦C-Lightning (C++)

◦Eclair (Scala)

•  Two important transactions that are propagated onto the blockchain

◦ Funding transaction

◦Closing transaction
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Preliminaries



•Payment routing through multiple hops is also possible

•Gossip messages

◦node_announcement – node_id

◦ channel_announcement

◦ channel_update – fee_base_msat
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Preliminaries

Alice Bob Carol



•Recorded from March 2018 to January 2020

◦400.000 node_announcement messages

◦1 million channel_announcement messages

◦6.4 million channel_update messages

•Goals

◦Classify nodes based on the default values in these gossip messages

◦Perform a geographical analysis with the data set and labeled data

•Publicly available at  https://github.com/lnresearch/topology
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Data set

https://github.com/lnresearch/topology


•Attackers may want to deduce private default values by inferring the client of a given node

•Nodes can flood the network with messages

◦Up to 1000 messages a day

• In two years a many nodes & channels are created and many updates happen

◦How to process this amount of data?
 Most frequent values

 Most frequent classification
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Node Classification
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Node Classification – Labeling



•Observance

◦Most nodes use default values
 LND: 40 (144 old)

 C-Lightning: 14

 Eclair: 144

•Possible classification approach without 
default values

◦Measure performance in network
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Node Classification – Default values



• First version of C-Lightning in 2016

◦Offered only source code

◦Had to be compiled on Linux or UNIX based systems

• First LND version in 2017

◦Offered precompiled version for various OS including Windows

◦Easy installation process
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Node Classification – Implementation Distribution



•Nodes can be classified based on default values in the gossip messages

•Collect data over a longer period to improve success, since the user could have changed the values

•Most users stick to the default values

• LND is by far the most popular client

◦Precompiled version

◦Available for Windows from the beginning
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Node Classification - Takeaways
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Geographical Analysis – Implementation Distribution
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Geographical Analysis – Channel Connections
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Geographical Analysis – Europe & North America
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Geographical Analysis - Asia
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Geographical Analysis – Germany
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Geographical Analysis - Japan
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Geographical Analysis – Channel Connections



• LND is predominant in 78 out of 81 observed countries

•Countries where LND is not predominant usually have only a few nodes

•Nodes connect to the same large hubs in the same countries, distance does not play an important 
role

•We can observe that locations, where the node density is higher, tend to have a better 
infrastructure overall

07/01/2021 Node Classification and Geographical Analysis of the Lightning Network Page 19

Geographical Analysis - Takeaways



• Nodes in the LN can be classified by using the default values in the gossip messages

• Users can easily change the values, but most of them stick to the default settings

• Is there any other possibility of classification?

• Since there are three implementations, measuring differences in network performance 
could be done

• LND is by far the most used client in almost all 81 observed countries

• Nodes tend to connect to large hubs, no matter the distance

• There is also a high connection within countries

• Possibly due to larger node providers, whose nodes are interconnected
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Summary



Template for traditional presentations
Font Calibri, version 1.5, 22 February 2017



• This sample presentation contains information about how to use this template. It shows all slide 
layouts, this template offers. Photos in this file are the work of Joseph Krpelan und Barbara Mair.

•When creating your presentation please follow the guidelines in this sample presentation,  which 
can also be used as a starting point for your presentation. In this case delete all slides/texts and fill 
in your own content. 

• In addition to layouts (details on layouts on page 5), that enable an easy creation of presentations, 
the template also offers the corporate design colours and fonts .

• Furthermore you will find instructions based on Microsoft Office 2013 (and similar in other Office 
versions). 
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Basics 1/3



• The following types of presentation templates are available (both with 
font Source Sans Pro and Calibri)

◦Template for traditional presentations (e.g. for image purposes) 
in format 16:9

◦Template for teaching and research in format 4:3

•Please note that the font Source Sans Pro is not installed on every 
computer – in case of doubt (e.g. for conferences) please use the 
template based on font Calibri.
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Basics 2/3



Basics 3/3
•Please avoid copying and pasting slides between the templates. 

By applying the option Use destination Style your slides will be adapted 
to the template, but follow-up processing will be necessary in most cases. 

• Furthermore there is a handout template for teaching and research 
available. This template can be used for preparing handouts with 
PowerPoint, which will not be presented via beamer. The template 
features a smaller font size for running text. 
Please do not use this template for your presentations!
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Available slide layouts for traditional presentations



• The template offers several slide layouts, that will assist 
you in creating your slides. Please make use of them!

•Please note that for technical reasons, the slide names 
are in German (but explained in detail in this sample file).

•  Choose a layout when creating a new slide: 

◦Click on the lower part of the button New Slide 
(ribbon/menu bar > Home > Slides). 

◦Then you will see all available layouts. 

◦ Select the appropriate layout.
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Use of layouts for new slides



• You can also change a slide layout later: 

◦Click on Layout (1) (ribbon Home > Slides) and select 
the desired layout from the dropdown menu.

• In some cases it might be necessary  to reset the layout 
of your slide  by selecting Reset (2) (on ribbon Home > 
Slides).
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Change slide layouts afterwards
1

2



Tips for text layout
•Please use the placeholders located on the layouts to enter your text or 

other elements. Avoid using manually placed text boxes.

• The sample slides (page 21 onwards) contain detailed information 
on font sizes, which are also pre-set in the placeholders. 

•By using bullets (1) and list levels (2) on ribbon Home > Paragraph 
you have several options to arrange your text. 

•Please note: text size does not automatically resize when too much text 
is entered in a placeholder.
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1 2



• The slide layouts contain different types of placeholders; some allow the import of different 
content types (charts, tables, pictures, text), others only the import of pictures. In these 
placeholders you can easily insert pictures by clicking the placeholder and selecting the desired 
picture (from pc/file share). The picture will automatically be placed within the placeholder and 
resized. 

•Most layouts also offer placeholders for reference information. 
Note copyright-guidelines when using pictures!

• The templates also offer guides/grid-lines to easily align objects on your slides. By pressing the 
“ALT”-key you can deactivate the snap-to-grid function (further details here and here in 
Microsoft’s online help).
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Use of placeholders for pictures, charts, etc.

https://support.office.com/en-us/article/Snap-charts-pictures-and-objects-to-a-grid-to-align-or-format-them-D9C687FC-926E-4ECA-8CEF-952EED714012?ui=en-US&rs=en-US&ad=US
https://support.office.com/en-us/article/Move-a-text-box-WordArt-or-shape-dab7e591-bd7b-4dbc-a8e9-7c90a8de3a1f?ui=en-US&rs=en-US&ad=US


• The templates offer predefined colours – the 
Theme Colours (see picture on the right (1)).

• These colours will also be automatically 
applied to elements like shapes, tables or 
charts.

• For your information you also will find the 
R/G/B codes for the accent-colours.
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Colour codes

Accent colours: are automatically applied on charts, tables or SmartArt graphics.

Shades of accent colours: are automatically generated by PowerPoint and are also 
used for charts or graphics. 

Standard colours: can be used on demand as well as user-defined colours

Theses colours 
are relevant for 
backgrounds or 

fonts

0
99
166

Accent 1

167
28
73

Accent 2

221
72
20

Accent 3

246
168
0

Accent 4

148
193
84

Accent 5

17
137
122

Accent 6

1

2

3

1

2

3



• The accent colours are also used in Theme Styles 
(e.g. used for colouring shapes). Please apply a uniform 
style for graphics (clear use of  shape and colour).

•Preferably simple styles should be used – especially 
with complex content.
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Further use of the accent colours

Please prefer this 
theme style  for 

colouring 
graphics!



•Choose Header & Footer (in ribbon Insert > Text). 

•Activate the desired checkboxes and enter a footer text.

•Please make sure the checkbox next to Don’t show on 
title slide is activated. 

•Confirm by selecting Apply to all.

•Please do not change the footer/slide number/date 
via the slide master – this may cause problems!
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Insert consistent footer information



Toner- and ink-reduced printing
• The optimised PowerPoint templates allow you to save toner and 

ink when printing. 

• Select the desired option in the print dialogue  via ribbon File > 
Settings, if you do not need printout in colours: 

◦Greyscale: graphic elements, charts etc. will be printed in 
greyscale. 

◦Black: elements will be printed in black (and grayscale fill in 
charts will be replaced by patterns)

•Please also select Frame Slides, in order to present slides more 
clearly, especially when several slides are printed per page. 
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Change the format of old slides/presentations



Apply the new design to old presentations 1/2
•As PowerPoint does not offer automated functions for converting old 

presentations to the new design, higher initial effort might be necessary, 
if you want to reuse old slides/presentations. 

• In order to apply the new design, open an existing presentation in 
PowerPoint and copy the slides you want to use.

•Open the required template and paste your slides. Please use the pasting 
option Use Destination Theme (see picture).
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Apply the new design to old presentations 1/2
• In some cases follow-up processing might be necessary for some slides.

• If your slides do not look as expected, please assign the appropriate slide 
layout to the relevant slide: select the slides and use Layout (in ribbon 
Home > Slides).

•  For most slides the layout Titel und Inhalt is suitable.

• In order to delete manual formatting, choose Reset
(ribbon Home  > Slides). 
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Tips for troubleshooting
• If your old presentations were not based on placeholders or the layouts 

were very different, text will not automatically be placed in the 
place-holders. In this case you have to copy and paste the text manually 
and reset your slides afterwards. 

• Furthermore it may happen (depending on the previously used 
template), that graphics (old logos, lines, etc.) still appear on your slides. 
If it is not possible to delete these elements within the slides, please go 
to Slide Master View (Ribbon View > Master Views) and try to delete the 
wrong elements there. 
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Adjustment of different footers 1/3
• If you use slides from different presentations (with different footers), 

these elements are not adjusted automatically (this may be the case with 
older versions of PowerPoint).

• In order to unify these elements:

◦Go to a slide that contains the correct footer elements 

◦Chose Headers & footers (in ribbon Insert > Text) and select Apply to all.

◦ In many cases this solves the problem.
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Adjustment of different footers 2/3
• If this does not work, try the following steps:

◦Reset layout for slides with wrong footers (ribbon Home > Slides).

◦Go back to a slide that contains the correct footers. 

◦Chose Headers & Footers (in ribbon Insert > Text) and deselect all 
checkboxes.

◦Then select Apply to all.
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Adjustment of different footers 3/3
◦Please stay on a slide where the footer was correct before and re-open 

the Headers & Footers dialog again (in ribbon Insert > Text). 

◦Now select all required checkboxes for date, slide number and footer, 
check the footer text and confirm by Apply to all. 

◦Now all footers should be fixed.

• Further information: Change or delete header and footer information 
in a presentation
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https://support.office.com/en-us/article/%C3%84ndern-oder-L%C3%B6schen-von-Kopf--und-Fu%C3%9Fzeileninformationen-in-einer-Pr%C3%A4sentation-31fd1e84-ccc7-47be-89ba-cc80be68c500?ui=de-DE&rs=de-DE&ad=DE&fromAR=1
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Sample layouts



Layout “Titelfolie mit Bild” – single-line – 36pt
Subtitle – 18 pt

Picture size 
11.5 x 33.9 cm



Layout “Titel und Inhalt” = default layout 
Title – 28 pt
•Running text 22 pt, layout offers a content placeholder.

• Sample text: Far far away, behind the word mountains, far from the 
countries Vokalia and Consonantia, there live the blind texts. Separated 
they live in Bookmarksgrove right at the coast of the Semantics, a large 
language ocean. 

•A small river named Duden flows by their place and supplies it with the 
necessary regelialia. It is a paradisematic country, in which roasted parts 
of sentences fly into your mouth. 

•One day however a small line of blind text by the name of Lorem Ipsum 
decided to leave for the far World of Grammar. 
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Layout “Titelfolie ohne Bild” – 36 pt
Subtitle, also two lines … – 18 pt



•Running text 22 pt, layout offers a larger content placeholder.

• Sample text: Far away, behind the word mountains, far from the countries Vokalia and 
Consonantia, there live the blind texts. Separated they live in Bookmarksgrove right at the coast of 
the Semantics, a large language ocean. 

•A small river named Duden flows by their place and supplies it with the necessary regelialia. It is a 
paradisematic country, in which roasted parts of sentences fly into your mouth. 

•One day however a small line of blind text by the name of Lorem Ipsum decided to leave for the 
far World of Grammar. The Big Oxmox advised her not to do so, because there were thousands of 
bad Commas, wild Question Marks and devious Semikoli, but the Little Blind Text didn’t listen. 
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Layout “Titel und Inhalt breit” for lots of text 
with header (also two lines)



Subtitle– 16 pt

Layout “Abschnittsüberschrift”– 28 pt

Picture size 
11.5 x 33.9 cm



Layout “Abschnittsüberschrift ohne Bild” – 
Title also possible in two lines – 28 pt
Subtitle – 16 pt



• This layout offers two content placeholders.

• Sample text: Far away, behind the word 
mountains, far from the countries Vokalia and 
Consonantia, there live the blind texts. 

•A small river named Duden flows by their place 
and supplies it with the necessary regelialia. It 
is a paradisematic country, in which roasted 
parts of sentences fly into your mouth. 
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Layout “Zwei Inhalte”



Advantages (or other title)

• Sample text: Far away, behind the word 
mountains, far from the countries Vokalia and 
Consonantia, there live the blind texts.

• Separated they live in Bookmarksgrove right at 
the coast of the Semantics, a large language 
ocean. 

Disadvantages (or other title)

• Sample text: A small river named Duden flows 
by their place and supplies it with the 
necessary regelialia. 

• It is a paradisematic country, in which roasted 
parts of sentences fly into your mouth. 

•One day however a small line of blind text by 
the name of Lorem Ipsum decided to leave for 
the far World of Grammar. 
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Layout “Vergleich”



Running text 18 pt 
Two content placeholder with smaller font size. 

• Sample text: Far away, behind the word mountains, far 
from the countries Vokalia and Consonantia, there live 
the blind texts. Separated they live in Bookmarksgrove 
right at the coast of the Semantics, a large language 
ocean. 

• A small river named Duden flows by their place and 
supplies it with the necessary regelialia. It is a 
paradisematic country, in which roasted parts of 
sentences fly into your mouth. 
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Layout “Zwei Inhalte Text klein”

Reference, source or copyright information in 12 pt Reference, source or copyright information in 12 pt



•Content placeholder on the left, picture placeholder on 
the right.

• Sample text: Far away, behind the word mountains, far 
from the countries Vokalia and Consonantia, there live 
the blind texts. Separated they live in Bookmarksgrove 
right at the coast of the Semantics, a large language 
ocean. 

•A small river named Duden flows by their place and 
supplies it with the necessary regelialia. 
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Reference, source or copyright information

Layout “Inhalt mit Bild rechts” Picture size 
11.5 x 12.2 cm



•Picture placeholder on the left, content placeholder on 
the right.

• Sample text: Far away, behind the word mountains, far 
from the countries Vokalia and Consonantia, there live 
the blind texts. Separated they live in Bookmarksgrove 
right at the coast of the Semantics, a large language 
ocean. 

•A small river named Duden flows by their place and 
supplies it with the necessary regelialia. It is a 
paradisematic country, in which roasted parts of 
sentences fly into your mouth. 
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Reference, source or copyright information

Layout “Inhalt mit Bild links”

Picture size 
11.5 x 12.2 cm



Layout “Bild abfallend mit Titel”

Picture size 
12.7 x 33.9 cm
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Reference, source or copyright information

Layout “Bild groß mit Text”
Running text 16 pt
Larger picture placeholder on 
the left, text placeholder on 
the right

Sample text: Far away, behind 
the word mountains, far from 
the countries Vokalia and 
Consonantia, there live the 
blind texts.

 Separated they live in 
Bookmarksgrove right at the 
coast of the Semantics, a large 
language ocean. 

Picture size 
12 x 23.7 cm
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Reference, source or copyright information

Running text 16 pt 
Header, larger picture 
placeholder on the left, text 
placeholder on the right 

Sample text: Far away, behind 
the word mountains, far from 
the countries Vokalia and 
Consonantia, there live the 
blind texts. Separated they live 
in Bookmarksgrove right at the 
coast of the Semantics, a large 
language ocean. 

Layout “Titel, Bild groß mit Text”

Picture size 
9.5 x 23.7 cm



Layout “Zwei Bilder mit 
Text rechts” – running 
text 16 pt

Two picture 
placehol-ders and text 
place-holder on the 
right

Sample text: Far away, 
behind the word 
mountains, far from the 
countries Vokalia and 
Consonantia, there live 
the blind texts. 
Separated they live in 
Bookmarksgrove right at 
the coast of the 
Semantics, a large 
language ocean. 
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Reference, source or copyright information Reference, source or copyright information

Picture size  
12 x  12.1 cm each



Running text 16 pt

Title, two picture 
placeholders and text 
placeholder on the right

Sample text: Far away, 
behind the word 
mountains, far from the 
countries Vokalia and 
Consonantia, there live 
the blind texts. 
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Reference, source or copyright information Reference, source or copyright information

Layout “Titel, zwei Bilder mit Text rechts”

Picture size
9.5 x  12.1 cm each
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Layout “Titel, zwei Bilder”

Reference, source or copyright information Reference, source or copyright information

Picture size
9.5 x 15.4 cm each


